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TOPIC 1 

SPREADSHEET SOFTWARE 
 

A spreadsheet is used to carry out everything from simple addition to complex financial and statistical 

analyses.  Spreadsheet programs can also help you create charts and graphs based on the data you’ve 

entered. 

Types/Brand Names of Spreadsheet Software 
 Microsoft Excel 

 Microsoft Works Spreadsheet 

 Lotus 1-2-3 
 

BASIC MS EXCEL SKILLS 
Starting Up Microsoft Excel 

1. Click on START, choose PROGRAMS and click on Microsoft Excel 
2. You will see a white grid in front of you with rows of menus and icons at the top of the screen. 
 

The Key Components of a Spreadsheet 

1. Title Bar: The bar that displays the name of the spreadsheet you currently have open.  
2. Name Box: The box that displays the address of the cell that you are presently on. 
3. Formula Box: The bar where the contents of the cell are displayed. 
4. Worksheet Tabs: These tabs allow you to switch from one worksheet to another. The standard 

spreadsheet contains three worksheets.  
 
 
 
 



 

 4 www.masomomsingi.co.ke 0728 776 317 

 

 
 

 

 

Note: Terms 

Cell – a single worksheet division  

Header – identities/addresses to column, rows and cells  

 Column[A,B,…], Rows[1,2,…] and Cell [A1] 

 Cells – headers are in terms of cell position within a column and a row [A1 is a cell 

within column A and row 1 and A5 is a cell within column A and row 5] 

Reference – the act of accessing/using cell addresses especially in formulas and functions 

Types of references 

a) Single cell –  addressing a single cell [i.e. A1] 

b) Range of cell – addressing a group of cells [i.e. A1:A5- vertical,A1:F1 - horizontal] 

Ways of referencing 

a) Relative – in a formulae, reference to cells(s) are based on their position relative to 

the cell  that contain the formulae 

b) Absolute  - the cell referred to is the same no matter which cell refers to it 

Functions and formulas 

 Function – readymade/ predefined mathematical procedures, built into the program library  to 

perform a series of operations on a specified range of values (i.e. average, sum, if etc. – 

Title Bar 

Name Box 

Formula Box 

A Cell 
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Average(A1:A5)) 

Formulae – user defined formulae (i.e. =A1+A2+A3) 

 

 

Entering Data into a Spreadsheet 

1. To enter data into a cell, simply click into the cell and type. 
2. ACTIVITY:   

a. Start in cell A1, and type “Day of the Week”.  Press Enter, or click your mouse into cell 
A2 and type “Monday”.  Continue down Column A until you’ve typed Monday through 
Sunday. 

b. Click on cell B1 and type “Customers”.  Proceed to cells B2-B8 begin typing in the 
numbers: 20, 10, 30, 50, 60, 100, and 70. 

 

EXCEL FORMULA AND FUNCTIONS  
Entering a Formula into a Spreadsheet 

1. What is a formula?  It is a command that instructs Excel to carry out a calculation.  Addition, 

 

TOPIC 2 

DATABASE SOFTWARE 

A database is an organized collection of data. It is the collection of tables, queries, reports, 

views, and other objects. The data are typically organized to model aspects of reality in a way 

that supports processes requiring information, such as modelling the availability of rooms in 

hotels in a way that supports finding a hotel with vacancies. 

A database management system (DBMS) is a computer software application that interacts with 

the user, other applications, and the database itself to capture and analyze data. A general-

purpose DBMS is designed to allow the definition, creation, querying, update, and administration 

of databases. Well-known DBMSs include MySQL, Oracle and MS Access 
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Features of Microsoft Access  

Introduction to Microsoft Access 

Ms Access is a database management tool that enables one to have good command of 
data collected. The programme enables one to retrieve, sort, summarize and report 
results speedily and effectively. It can combine data from various files through creating 
relationships, and can make data entry more efficient and accurate.  
Microsoft Access (MS Access) enables one to manage all important information from a 
single database file. Within the file, one can use:  
• Tables to store your data.  
• Queries to find and retrieve specific data of interest.  
• Forms to view, add, and update data in tables.  
• Reports to analyze or print data in a specific layout.  
• Data access pages to view or update, the data.  
In MS Access, data is stored once in one table, but can be viewed from multiple 
locations.  
When the data is updated in a Table, Query or Form, it is automatically updated 
everywhere it  
appears  

 

Microsoft Access is a relational database management system for 
windows. Using this package, following tasks can be performed. 

 

 Organize data into manageable related units Enter, 
modify and locate data   

 Extract subsets of data based on specific criteria Create 
custom forms and reports   

 Automate common database tasks Graph 
database relationships  

 Add clipart to forms and reports  
 Create macros for automating various functions   
 Create database applications, consisting of modules linked through 

menus, dialog boxes, and command buttons.   
 In Access, the term Database refers to a single file that contains a 

collection of information. Each Access Database consists of tables, 
queries ,forms reports, macros and modules  

 

Database Concepts 

 

Field Names 

These should be meaningful, without spaces or punctuation, such as SNAME 
(surname), FNAME (first name), DOB (date of birth), ADDRESS1 (first line of 
address), TOWN, PCODE, PHONE etc. You cannot have two fields with the 
same name. 
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Field Types 
 Text for text and whole numbers that aren’t going to be used in 

calculations(e.g., age, phone number)  
 Date/Time for dates and time   
 Numbers for decimals and numbers that are going to be used in 

calculations, e.g. sales figures  
 Currency for money   
 Yes/No for true/false logical values, e.g. a “married” field, field could 

be logical.  
 

 

Field length 
This has to be fixed, so you need to plan your database structure beforehand 
(although you can alter the length later). 
 

Required Fields 

This box is for when you want to force the user to enter data in a field 

 

Primary keys 

These are used to sort the records to allow fast access. Access encourages 
you choose one field as the primary key field, and then sorts the records on 
this field. However, only one record with the same value is allowed in the 
primary key field, for example if you choose surname for the primary key, 
you can only have one Smith, Jones etc. For this reason, you should always 
choose a numeric or a counter field for the primary key: do not use surname 
as the primary key field. 
 

 

 

TOPIC 3 

USING A DESKTOP PUBLISHING SOFTWARE 
 

Microsoft Publisher is an entry-level desktop publishing application from Microsoft, differing from 

Microsoft Word in that the emphasis is placed on page layout and design rather than text composition 

and proofing 
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Publisher is included in higher-end editions of Microsoft Office, reflecting Microsoft's emphasis 

on the application as an easy-to-use and less expensive alternative to the "heavyweights" with a 

focus on the small business market where firms do not have dedicated design professionals 

available to make marketing materials and other documents. However, it has a relatively small 

share of the desktop publishing market, which is dominated by Adobe Applications.  

In Microsoft Office 2007, while most of Microsoft Office apps adopted ribbons in their user 

interface, Publisher retained its toolbars and did not adopt ribbons until the next version 

Publisher Basics and Features  

Microsoft Publisher 2007 is a desktop publishing program that can be used to create a variety 
of publications. Using Publisher, you can easily create business cards, greeting cards, 
calendars, newsletters and much, much more.  
Unlike the other programs in Microsoft Office 2007, Microsoft Publisher 2007 uses the Microsoft 
Office Toolbar and a Menu system in place of the Microsoft Office Ribbon. 
 
Some Useful Definitions: 

 

Frame – Most publications are divided into several different areas called frames. A 
frame can contain a variety of objects such as graphics, tables, or text boxes. Frames can 
be resized, moved and manipulated to suit your needs. 

 

Handles – When you click on a frame, small circles appear around the edge of the 
frame. These are called handles. You can click and drag on the handles to resize your 
frame. 

 
 
 
 
 
 

 

 

Template ‐ A Template is a tool used in Publisher to help you easily create basic 
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publications. The template has a set of pre‐chosen design styles that you can use 
as it is or customize as you see fit. 

 

Opening Publisher 
 
To Open Publisher either: 
 

Double click on the Microsoft Publisher Icon on your desktop, OR 
 

‐OR 
 

Click on Start in the lower left hand corner of your desktop, move up to 
Programs, and then click on Microsoft Publisher 

 
 
Creating New Publications with Publisher. 

 

When you first open Publisher, Publisher offers you a number of different publication types 
to start with. 

 

Click on one of the publication types in the main window or in the list on the left side of the 
main window to view a list of templates that will walk you through the process of making basic 
design choices for your publication. These choices include color schemes, font styles, and more. 
 

 

 

Examples  
To Create a Calendar: 
 
1. Open Microsoft Publisher by double clicking the icon on the desktop or finding it under 

the start menu.  
 
2. Click on Calendars from the main window or the list on the left. A selection of pre‐ 

designed templates appears for you to choose from.  
 
3. Click on one of the pre‐designed templates that you like. It will appear at the top of the 

area on the right side of the page.  
 
4. You can either stick with the default design choices that are part of the template, or you can 

customize them by clicking the downward pointing arrow to the right of a design section 
and choosing any of the options provided by clicking on it.  

 
5. Click on the Set Calendar Dates button and choose the period of time that you would 

like your calendar to cover.  
 
6. Click on Create at the bottom to create your caledar.  
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Now that you have made your basic calendar selections, it is time to further customize the 
publication. 
 

Creating a Business Card 
 

1. Open Microsoft Publisher by double clicking the icon on the desktop or finding it under 
the start menu.  

 
2. Click on Publications for Print then Business Cards, and finally Accent Box 

Business Card.  
 

3. In the personal information form that opens, 
enter your own contact information and click on 
OK. (If you accidentally close your personal 
information and you want to edit it further, click 
on the Edit Menu and  
Personal Information to retrieve the form.)  

 
4. In the task pane on the left side of the window, 

you are given different options you can adjust. 
As you click on the different steps at the top of 
the task pane, the options change on the lower 
part of the task pane.  

 
5. Click on Business Card Options.  

 
a. Choose to Include a logo.  

 
b. Choose the traditional Landscape 

orientation  
 

c. Choose to have Multiple copies per 
sheet  

 
6. Click on Publication Designs.  

 
a. Leave the selected Accent Box.  

 
b. Click on Color Schemes and select the desired color scheme.  

 
7. Click on Font Schemes and select the desired font scheme.  

 

Now that you have completed the Business Card Wizard, you can customize the 
business card. Change the format or insert additional clip art, if you wish. 
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Creating a Personalized Greeting Card 

 

1. Open Publisher by double clicking the icon on the desktop or finding it under the start 
menu.  

 
2. Click on Publications for Print  Greeting Cards  Birthday  Birthday Card  

72  
 

3. Click on Greeting Card Options  
 

a. Select Greetings Bar.  
 

b. Select Full Verse  
 

c. Click on Select a suggested verse. A dialog 
box will open click on a verse on the left 
side and on the right side it will show you 
the front message and the inside message. 
Select the verse you would like to use and 
click on OK.  

 
i. 

 
• Click on Page Options  

 
 Choose the Quarter page side fold 
option.  
 

• Click on Card Gallery  
 
 Leave Birthday 72 selected.  
 

• Click on Color Schemes  
 
 Select the desired color scheme.  
 

• Click on Font Schemes  
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 Select the desired font scheme.  
 
 
 

 

Now that you have completed the Greeting Card Wizard, you can customize the 
greeting card. 

 

At the bottom of the screen are sheets with numbers on them (1, 2, 3, 4). Click on 1 to see the 

front of the card. Click on 2 or 3 to see the inside of the card. Click on 4 to see the back of the 

card. 

Customizing a Publication (Working with text and objects) 

Working with Frames 
 
Each publication is composed of different frames, such as text frames, picture frames, table 
frames, and shape/object frames. Click on different areas of the calendar to identify the 
different frames. Handles, little circles on the corners and sides of the frame will appear. The 
handles help show which frame you have selected. They are also used in resizing frames. 

 

Moving Frames 
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Deleting Frames  
1. Right click on the frame that you would like to delete.  

2. Select Delete Object from the list of choices.  
 

Formatting Text  
1. Click in a text frame.  

2. Begin typing.  

3. Click and drag over the text you typed to select it for formatting changes.  

4. Use the Formatting Toolbar or click on Format Font to make changes to the text’s 
appearance 

 

Undoing Changes  

Creating a publication often involves trial and error. Unlike many of Microsoft Office’s other 
applications, in Publisher you cannot preview what a change is going to look like until you apply it.  

To undo actions, click on the undo button on the standard toolbar or click on Undo in the Edit 
Menu.  



 

 14 www.masomomsingi.co.ke 0728 776 317 

 

Inserting Additional Text Frames  
1. Click on Text box from the Insert Menu  

2. Click and drag over an area of the publication.  

3. Type the text you want to appear.  
 
Inserting Clip Art  

If you want to change the picture in an existing picture frame,  
1. Right click on the picture and select Delete Object.  

2. Click on Insert Picture Clip Art.  

3. A Clip Art search interface will open in the task pane.  

4. Enter a search term and press Go.  

5. You can choose to limit the search to a particular collection or a particular media type.  

6. Once you discover the desired clip art, click on it to insert it.  
 
Notice that the clip art has a drop down arrow next to it. If you click on the drop down arrow other 

options present themselves. You can click on Find Similar Style for clip art of similar design. You can 

click on Preview/Properties to view the original size of the clip art and what keywords were used to 

classify the picture. 

Create a table 
Create a table and type text into it  

1. On the Objects toolbar, click Insert Table . 

2. Click inside your publication.  

The Create Table dialog box will appear. 

3. Select the options you want, and then click OK. 

4. Size your table.  

How?  

Select the table, position the mouse pointer over a selection handle until you see the 

Resizer icon, and then drag to resize the table. 

5. In the table, click the cell where you want to add text, and then start typing.  

To add text to another cell, click inside that cell. 

Each cell expands to fit your text, unless you lock the table size by clearing the check 

mark next to Grow to Fit Text on the Table menu. 
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Create a table from existing Microsoft Publisher text  
1. If the text is in a table, select the cells you want. 

If the text is in a text box, make sure there's a tab or comma between each entry in a row, 

and a paragraph mark at the end of each row. 

2. Highlight the text. 

3. Right-click the highlighted text, and then click Copy. 

4. On the Edit menu, click Paste Special. 

5. In the As list, click New Table. 

6. Click OK. 

Create a table by using text from another program  
1. Open the program that contains the text you want. 

If the text isn't already in a table, press TAB between each entry within a row of text, and 

press ENTER at the end of each row. 

2. Select the text, and then press CTRL+C to copy it.  

3. Open your Publisher publication and go to the page you want to change. 

4. On the Edit menu, click Paste Special. 

5. In the As list, click New Table. 

6. Click OK. 

Note: Depending on how your text was formatted in the other program, you might want 

to reformat the text after it becomes a Publisher table. 

 

Working with Color Schemes 
A color scheme is a set of colors that you group together to use with your publication. You may 

want to create a color scheme for specific projects or simply to maintain and quickly access the 

colors you use most frequently. A color scheme can also be used to develop a consistent, 

polished look for your publication. Colors in a color scheme may be applied to any element of 

the publication. This document contains sections on the following topics: 

 Creating a Custom Color Scheme 
 Applying a Color Scheme 
 Using the Colors of a Color Scheme 

Creating a Custom Color Scheme 

Your color scheme will most likely consist of colors that complement each other as well as some 

that provide contrast. You can create and save multiple schemes for use in a variety of 

publications. 

1. Create or open a publication 
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2. On the Publisher task pane, click COLOR SCHEMES  

OR 
From the Format menu, select Color Schemes... 

The Color Schemes task pane appears. 

 
3. At the bottom of the task pane, click CREATE NEW COLOR SCHEME...  

The Create New Color Scheme dialog box appears.  
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In the File name box, type the name of the file you are updating, and then click Save. 

 

 

 

 

 

TOPIC 5 

EMERGING ISSUES AND TRENDS 
 

Trends that Are Dramatically Changing Work and the Workplace  

The Changing Nature of Work 
My wife, a manager at Hewlett-Packard, usually has a two minute commute—a thirty foot walks 

from the kitchen up to her office. She goes “to the central office” about once every other week, 

more to keep in touch socially rather than to formally collaborate. Although she only meets face-

to-face with her globally-based team members about once per year, she has an audio conference 

with them weekly. As HP’s work force grows and becomes more global, she is a highly sought 

after manager. She has learned how to work with her distributed team, setting clear directions, 

communicating often and clearly, and, most importantly, creating activities to engender team 

trust and cohesion.  

Most workers today do not work like my wife; most still commute to and from traditional, 

centralized offices and work with teams in close proximity. Nevertheless, more and more of us 

are—or will be—working in both non-traditional ways and places, ranging from relying on 

adaptable furniture and hoteling desks at the central office, to satellite offices, offshore offices, 

and telework from home. 

According to a recent benchmarking study by our research consortium, The New Ways of 

Working, many organizations are formalizing “Alternative Workplace” programs that combine 

nontraditional work practices, settings and locations. 

Almost half of the surveyed organizations have started an alternative workplace program within 

the past two years and a large majority within the past five years. This is striking as these 

programs have been around since the early 1980s. 
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The same study indicates that the adoption of such programs has accelerated during the recent 

Great  

Recession and shows no sign of letting up. Why, after all these years, is this happening now? 

Why has the pace of change picked up so dramatically? What does it mean for how and where 

we will work in the future? This paper identifies five trends that are dramatically changing work 

and workplaces.  

The first two trends have been around for more than a quarter of a century:  

1. The continuing distribution of organizations 

2. The availability of enabling technologies and social collaboration tools  

Their adoption has pushed alternative ways of working well past the pioneering stage and into 

the mainstream, when enough organizations “have adopted an innovation in order that the 

continued adoption of the innovation is self-sustaining.” 

 

These two trends will be reinforced by three more that will induce further change:  

3. The coming shortage of knowledge workers  

4. The demand for more work flexibility  

5. Pressure for more sustainable organizations and work-styles  

Collectively, these trends are most pronounced in technology companies, the sector that has 

historically led the way in adoption of new technologies and workstyles that go with them. 

However, as technology has become more integral to the operation or mission of organizations, 

these themes are permeating the larger work community.  

Importantly, these trends generally don’t impact the workplace directly, but have more to do with 

affecting how we work. The physical workplace is far more than just furnishings and real estate; 

it is also about how people work and are managed, the technologies that enable the work, and 

how the organization employs the workplace for its own ends. Going further, the workplace even 

reflects forces of the larger social and economic environment.  

 

 

THIS IS A SAMPLE 

TO GET  COMPLETE NOTES, CALL/TEXT/WHATSAPP  

or 0728 776 317 

EMAIL:  info@masomomsingi.co.ke

 


